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About This Document 

This document describes various options for trading ebXML and EDI documents among B2B 
collaborators using BEA AquaLogic Service Bus™ 2.1 and Cyclone© Interchange 5.4 in an 
integrated environment. This document describes a range of common trading scenarios, from 
single end-point solutions to advanced clustered configurations that offer fault tolerance and high 
availability. This document focuses on methods to configure BEA AquaLogic Service Bus and 
Cyclone Interchange to work together. 

This BEA EDI Utilities Solution Guide covers the following topics: 

Chapter 1, “Installing EDI Utilities”

Chapter 2, “Introduction” 

Chapter 3, “Integrated EDI Solution” 

Chapter 4, “Designing the EDI Solution” 

Chapter 5, “AquaLogic Service Bus and B2B Gateway Integration Via JMS” 

Chapter 6, “AquaLogic Service Bus and B2B Gateway Integration Via Web 
Services” 

Chapter 7, “Integration Guidelines for EDI Solution” 

“Appendix A: Overburden Fault in Cyclone Interchange”

“Appendix B: Message Names for 4020 Version of X12 EDI Standard”
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“Appendix C: Message Names for D98B Version of EDIFACT EDI Standard”

What You Need to Know
This document has been certified with BEA AquaLogic Service Bus 2.1 and Cyclone Interchange 
5.4. 

Product Documentation on the dev2dev Web Site
BEA product documentation, along with other information about BEA software, is available 
from the BEA dev2dev Web site:
http://dev2dev.bea.com

To view the documentation for a particular product, select that product from the list on the 
dev2dev page; the home page for the specified product is displayed. From the menu on the left 
side of the screen, select Documentation for the appropriate release. The home page for the 
complete documentation set for the product and release you have selected is displayed.

Additional Information 
For additional information about: 

BEA AquaLogic Service Bus, see http://edocs/alsb/docs21/index.html

WebLogic Integration, see http://edocs/wli/docs85/index.html

Format Builder, see http://edocs/alsb/docs21/fbhelp/index.html

ebXML, see http://www.ebxml.org/

EDI, see http://en.wikipedia.org/wiki/Electronic_Data_Interchange

Cyclone Interchange, see 
http://www.bea.com/framework.jsp?CNT=index.htm&FP=/content/products/mor
e/cyclone/

Edifecs SpecBuilder, see http://www.edifecs.com/products/specbuilder/

Contact Us!
Your feedback on the BEA BEA AquaLogic Service Bus documentation is important to us. Send 
us e-mail at docsupport@bea.com if you have questions or comments. Your comments will be 

http://dev2dev.bea.com
http://en.wikipedia.org/wiki/Electronic_Data_Interchange
http://www.bea.com/framework.jsp?CNT=index.htm&FP=/content/products/more/cyclone/
http://www.edifecs.com/products/specbuilder/
http://www.ebxml.org/
http://edocs/alsb/docs21/index.html
http://edocs/wli/docs85/index.html
http://edocs/alsb/docs21/fbhelp/index.html


Documentat ion  Convent i ons

BEA EDI Utilities Solution Guide iii

reviewed directly by the BEA professionals who create and update the BEA AquaLogic Service 
Bus documentation.

In your e-mail message, please indicate that you are using the documentation for BEA BEA 
AquaLogic Service Bus 2.1.

If you have any questions about this version of BEA BEA AquaLogic Service Bus, or if you have 
problems installing and running BEA BEA AquaLogic Service Bus, contact BEA Customer 
Support at http://support.bea.com. You can also contact Customer Support by using the 
contact information provided on the quick reference sheet titled “BEA Customer Support,” which 
is included in the product package.

When contacting Customer Support, be prepared to provide the following information:

Your name, e-mail address, phone number, and fax number

Your company name and company address

Your machine type and authorization codes

The name and version of the product you are using

A description of the problem and the content of pertinent error messages

Documentation Conventions
The following documentation conventions are used throughout this document.

Convention Item

Ctrl+Tab Indicates that you must press two or more keys simultaneously.

italics Indicates emphasis or book titles.

http://support.bea.com
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monospace 
text

Indicates user input, as shown in the following examples:
• Filenames: config.xml
• Pathnames: BEAHOME/config/examples
• Commands: java -Dbea.home=BEA_HOME
• Code: public TextMsg createTextMsg(

Indicates computer output, such as error messages, as shown in the following example:
Exception occurred during event 
dispatching:java.lang.ArrayIndexOutOfBoundsException: No such 
child: 0

monospace 
boldface 
text

Identifies significant words in code.

Example:
void commit ( )

monospace 
italic 
text

Identifies variables in code.

Example:
String expr

{ } Indicates a set of choices in a syntax line. The braces themselves should never be typed.

[ ] Indicates optional items in a syntax line. The brackets themselves should never be typed.

Example: 
java utils.MulticastTest -n name [-p portnumber]

| Separates mutually exclusive choices in a syntax line. The symbol itself should never be typed.

Example: 
java weblogic.deploy [list|deploy|update]

Convention Item
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... Indicates one of the following in a command line: 
• That an argument can be repeated several times in a command line
• That the statement omits additional optional arguments
• That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.

Example:
buildobjclient [-v] [-o name] [-f "file1.cpp file2.cpp 
file3.cpp . . ."

.

.

.

Indicates the omission of items from a code example or from a syntax line. The vertical ellipsis 
itself should never be typed.

Convention Item
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Terminology Used 
The following terms are used in this document. 

Term Definition 

B2B Business-to-Business electronic commerce. B2B covers a broad range of business 
activities. For example, B2B systems exchange business documents, such as 
purchase orders and invoices, between partners in a supply chain. 

Backend system A system (such as WebLogic Integration) that sends documents to Cyclone 
Interchange to be delivered across the Internet, or to which Cyclone 
Interchange sends documents it receives across the Internet. 

Document Message traded between partners. In this document, a business document is 
assumed to be an EDI or ebXML document. 

Inbound Message received over the Internet from a partner. A trading engine unpacks 
an inbound message and sends it to a backend system for processing. 

Integration Delivery 
Exchange (IDE) 

Transport for delivering inbound messages (that Cyclone Interchange 
receives from a trading partner to a backend system. Supported integration 
protocols include file system, FTP, JMS, Web services, and MQ Series. 

Integration Pickup 
Exchange (IPE) 

Transport for picking up outbound messages from a backend system. Cyclone 
Interchange sends outbound messages to a trading partner. Supported 
integration transports include file system, FTP, JMS, Web services, and MQ 
Series. 

Message Business document traded between partners. In this document, a business 
document is assumed to be an EDI or ebXML document. 

Outbound Message sent over the Internet to a partner. The trading engine picks up the 
outbound message from a backend system and packages it before sending to 
the partner. 

Trading Exchange of e-commerce messages over the Internet between trading 
partners. 

Trading Engine B2B e-commerce gateway, such as Cyclone Interchange. 
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C H A P T E R 1

Installing EDI Utilities

This section provides information about:

Installation Prerequisites

Starting the Installation Program

Installation Prerequisites
Prior to installing EDI Utilities, make sure that you installed AquaLogic Service Bus 2.1 and 
Cyclone Interchange 5.4. 

Install the following patches before you start working with the BEA EDI Utilities solution. You 
can download the patches from http://commerce.bea.com. 

Install Patch IKQC 
After installing AquaLogic Service Bus, use the Smart Update tool to download and install patch 
IKQC on the server. After applying the patch, perform the following platform specific tasks. 

Windows – Replace set PRE_CLASSPATH= with set 
PRE_CLASSPATH=%PATCH_CLASSPATH% in the <Domain_Dir>/bin/setDomainEnv.bat 
file. 

UNIX – Replace set PRE_CLASSPATH= with set 
PRE_CLASSPATH=${PATCH_CLASSPATH} in the <Domain_Dir>/bin/setDomainEnv.sh 
file. 

http://commerce.bea.com
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Where <Domain_Dir> specifies the domain directory. Detailed information on this is 
available in Chapter 1, “Installing EDI Utilities” of the BEA EDI Utilities Solution Guide. 

Note: For information on how to use the Smart Update tool, see Installing Maintenance 
Updates and Service Packs at the following URL: 

http://e-docs.bea.com/common/docs91/smart_update/index.html 

Install Patch WB1Y 
Use the Smart Update tool to download and install patch WB1Y at the client side. After applying 
this patch, perform the following two tasks. 

Add %BEA_HOME%\ patch_weblogic910\patch_jars\ CR259279_910.jar to the 
client classpath definition. 

Set the system property -Dweblogic.MaxMessageSize to increase the message size limit. 

Following is a sample ant Java task to perform the above two settings: 

<java classname="com.bea.wli.b2b.jmsclient.JMSQueueReceiver" 
fork="true" maxmemory="1280m"> 

<classpath> 
<pathelement 

location="${BEA_HOME}/patch_weblogic910/patch_jars/CR259279_910.jar"/> 
<pathelement location="${WLS_HOME}/lib/weblogic.jar"/> 

</classpath> 
<sysproperty key="weblogic.MaxMessageSize" value="2000000000"/> 

<arg line="${xml.dir.path} ${I_PROVIDER_URL}"/> 
</java> 

For information on installing Cyclone Interchange, visit the following URL: 

http://www.cyclonecommerce.com/products/interchange.php 

Starting the Installation Program 
After you finish installing AquaLogic Service Bus 2.1 and Cyclone Interchange, you can install 
EDI Utilities 1.0. 

To Install EDI Utilities

1. Double-click on edi100_win32.exe.

The Welcome window of the BEA Installer wizard appears. 

2. Click Next. The BEA License Agreement window appears. 

http://www.cyclonecommerce.com/products/interchange.php
http://e-docs.bea.com/common/docs91/smart_update/index.html
http://e-docs.bea.com/common/docs91/smart_update/index.html


Star t ing  the  Ins ta l la t i on  P rogram

BEA EDI Utilities Solution Guide 1-3

3. Read the BEA Software License Agreement and indicate your acceptance of the terms of the 
agreement by selecting Yes. To continue with the installation, you must accept the terms of 
the license agreement and then click Next.

The Choose Installation Directories window appears. 

4. Specify the location in which you installed AquaLogic Service Bus 2.1 and click Next. 

5. Specify the location in which you installed Cyclone Interchange 5.4 and click Next.

6. Choose the shortcut location. 

The installation process starts.

7. Click Done to exit the installer. 

You have successfully installed EDI Utilities. 
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C H A P T E R 2

Introduction

This section provides information on the three point tools that form the EDI Utilities solution 
offering from BEA. 

BEA AquaLogic Service Bus
BEA AquaLogic Service Bus, part of BEA's family of Service Infrastructure Products 
(AquaLogic), combines intelligent message brokering with service monitoring and 
administration to provide an unified software product for implementing and deploying your 
Service-Oriented Architecture (SOA). This converged approach adds a scalable, dynamic routing 
and transformation layer to your enterprise infrastructure, plus service lifecycle management 
capabilities for service registration, service usage, and Service Level Agreement (SLA) 
enforcement. 

AquaLogic Service Bus is a configuration-based, policy-driven Enterprise Service Bus (ESB). It 
provides a feature-rich console for dynamic service and policy configuration, as well as for 
system monitoring and operations tasks. TheAquaLogic Service Bus Console enables you to 
respond rapidly and effectively to changes in your service-oriented environment. 

AquaLogic Service Bus relies on the run-time facilities of WebLogic Server. It leverages 
WebLogic Server capabilities to deliver functionality that is highly available, scalable, and 
reliable. For more information about AquaLogic Service Bus, see 
http://edocs/alsb/docs21/index.html

http://edocs/alsb/docs21/index.html
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Figure 2-1  AquaLogic Service Bus High Level Architecture 

With AquaLogic Service Bus you implement service integration relationships dynamically 
through configuration of policies and proxy services. This approach enables your service 
architectures to evolve rapidly with respect to the following system characteristics:

Security 

Service location 

Availability and responsiveness 

Data formats 

Logging and monitoring 

Transport protocols and communication paradigms 
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Due to the intermediary nature of the proxy service, you can use AquaLogic Service Bus to 
resolve differences between service client and business service requirements in the following 
areas:

Payload contents and schema 

Envelope protocols 

Transport protocols 

Point-to-point, and publish and subscription protocols 

One way and request/response paradigms 

Synchronous and asynchronous communication 

Security compliance 

AquaLogic Service Bus persists policy, proxy service, and related resource configurations in 
metadata that you can propagate from development through staging to production environments, 
and then modify as required. The AquaLogic Service Bus message brokering engine accesses this 
configuration information from its metadata repository. 

A key design philosophy of AquaLogic Service Bus is the physical separation of management 
functions from service implementations. This separation allows implementations to evolve 
independently and dynamically as driven by the needs of the business without requiring costly 
infrastructure development efforts. As part of an enterprise's messaging fabric, AquaLogic 
Service Bus can be used horizontally across many applications and systems, spanning service 
implementations in different departments built by different teams. 

Cyclone Interchange 
Cyclone Interchange is a B2B e-commerce gateway that provides a secure, scalable foundation 
for B2B or internal collaboration. The unified framework helps establish relationships with 
trading partners, transact business over the Internet, and integrate with backend systems. Cyclone 
Interchange provides flexibility in connecting with partners and legacy systems using widely 
used protocols, transports, and integration methods. For more information about Cyclone 
Interchange, see http://www.cyclonecommerce.com/products/interchange.php.

Note: This document assumes that you are proficient with Cyclone Interchange series 5.4. For 
support and training in Cyclone Interchange, see: http://support.cyclonecommerce.com.

Cyclone Interchange can be implemented as a single end-point solution or as a clustered, 
fault-tolerant gateway with unlimited trading partners. Cyclone Interchange supports standard 

http://support.cyclonecommerce.com
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protocols for exchanging messages with partners, including AS1, AS2, AS3, ebXML, and 
RosettaNet. User-defined message routing and rules-based processing can be handled at the 
partner or document level.

Cyclone Interchange supports multiple operating systems, databases, and platforms. For more 
information about supported products, refer to "System Requirements" of the Cyclone 
Interchange Installation and Configuration document.

Cyclone Interchange has been certified for AS1, AS2, AS3, and ebXML interoperability. For a 
list of software certified for interoperability with Cyclone Interchange, see the eBusinessReady 
Web site, at the following URL: http://www.ebusinessready.org 

The following figure shows a typical high level architecture for Cyclone Interchange. 

Figure 2-2  Cyclone Interchange High Level Architecture 

Cyclone Interchange also supports other architectures, but this example is popular among 
business users. The exact architecture for a specific organization depends on many factors, 
including the organization's security policies, preferred protocols for exchanging documents over 
the Internet, backend integration requirements, and so on.

Cyclone Interchange's user interface integrates gateway management, monitoring, and metrics 
into a single view. Figure 2-3 shows a portion of the Cyclone Interchange user interface. 
Hyperlinked image components helps you to visualize and manage the trading configuration. 

Figure 2-3  Hyperlinked Visualization of Trading Configuration in Cyclone Interchange
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Edifecs SpecBuilder 
Edifecs SpecBuilder is the world's leading authoring tool for B2B guidelines. Guideline creation 
becomes fast, simple and painless for seasoned B2B analysts and novices alike. You can give 
your B2B projects a running start by modifying and annotating any of over 18,000 transaction 
templates that are included in SpecBuilder. Once the specification is created, it is published in 
different formats so that both internal team members and external trading partners work with the 
same guideline document. SpecBuilder allows you to standardize your B2B requirements process 
by using one tool for the widest available selection of electronic standards including X12, 
UN/EDIFACT, HIPAA, HL7, various XML formats, and proprietary formats such as IDOC from 
SAP. 

For more information about Edifecs SpecBuilder, see 
http://www.edifecs.com/products/specbuilder. 

You can also contact Edifecs at sales@edifecs.com.
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C H A P T E R 3

Integrated EDI Solution

AquaLogic Service Bus and Cyclone Interchange together provide an integrated EDI solution 
that supports trading ebXML, EDI X12, and EDIFACT documents. This solution has been tested 
with 4020 version of X12 and D98B version of EDIFACT standard. 

The messages that are sent and received should adhere to the EDI standards. For example, for a 
message based on the X12 standard, the ISA segment should be of length 106 characters 
(excluding the segment terminator).

This section provides information about:

Design Time Components

AquaLogic Service Bus and B2B Gateway Integration Via JMS

AquaLogic Service Bus and B2B Gateway Integration Via Web Service

EDI Splitter

Limitations of This EDI Solution

The following figure provides an architecture of this integrated EDI solution. 
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Figure 3-1  B2B Integration Architecture for AquaLogic Service Bus and Cyclone Interchange 

This tested solution leverages the strengths of AquaLogic Service Bus's message brokering, 
transformation and routing capabilities and the proven reliability of Cyclone Interchange's 
standards-based B2B trading. Integration solutions rely on either JMS or Web services as the 
integration mechanism between the two products. AquaLogic Service Bus and Cyclone 
Interchange can run on the same server, or they can be deployed on separate, independent servers. 
AquaLogic Service Bus can be deployed on a cluster. Cyclone Interchange can also be deployed 
on a cluster. 
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Figure 3-2  Runtime Overview of EDI Solution

Design Time Components 
The integrated B2B solution provides the transformation capabilities from EDI to XML and vice 
versa using AquaLogic Service Bus. To provide the transformation capabilities, the solution 
relies on Message Format Language (MFL). 

A Message Format Language (MFL) document is a specialized XML document used to describe 
the layout of binary data. It is a BEA proprietary language used to define rules to transform 
formatted binary data into XML data. An MFL document conforms to the mfl.dtd, which 
includes elements and attributes used to describe each field of data, as well as groupings of fields 
(groups), repetition, and aggregation.
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Note: Transformation can be done in different ways including using your built-in 
transformation mechanism. However, in the absence of any other transformation, you 
can use MFL to transform raw data to XML and vice versa. In addition, you can use MFL 
for transformation because the EDI solution includes AquaLogic Service Bus 2.1. 

For generating MFL document, we suggest that you use Edifecs SpecBuilder to generate 
the gXML guideline. You can later generate the MFL document from the gXML 
guideline by using tools provided by BEA. However, you can also manually write MFL 
maps to define the MFL. For more information about writing MFL documents, see 
http://e-docs.bea.com/alsb/docs21/fbhelp/overview.html.

The MFL documents must then be imported to AquaLogic Service Bus, using the 
AquaLogic Service Bus Console, to facilitate transformation. 

Edifecs SpecBuilder, which is a B2B authoring tool, is used to generate the guidelines for the 
EDI documents in the gXML format. Guideline XML (gXML) is an open specification designed 
to facilitate the exchange of e-commerce guidelines using eXtensible Markup Language (XML). 
Guidelines are used to define business documents such as purchase orders, catalog requests and 
invoices. The supported version of the gXML is 0.71. 

To generate MFL documents from gXML guidelines, BEA provides the Batch Converter, tool. 
The EDI Importer plugin to Format Builder can also be used for conversion gXML guidelines 
to MFL. If required, the transformed MFL documents can be customized to suite your 
requirements. 

Note: The EDI Importer plugin to Format Builder is only available if you install the IKQC 
patch. For more information see section Install Patch IKQC in Chapter 1, “Installing EDI 
Utilities.” 

AquaLogic Service Bus and B2B Gateway Integration Via JMS
Java Message Service (JMS) offers a reliable integration mechanism between AquaLogic Service 
Bus and Cyclone Interchange. JMS is the recommended transport mechanism for exchanging 
messages up to 4MB in size. 

There are two main scenarios to configure, which are based on the message direction. For more 
information, see Chapter 5, “AquaLogic Service Bus and B2B Gateway Integration Via JMS.”

Outbound Scenario
In an outbound scenario, the backend system sends a JMS message to the proxy service in 
AquaLogic Service Bus. The payload can be sent as is or as a file reference to the B2B gateway 
(file reference is not supported by Cyclone Interchange). AquaLogic Service Bus transforms the 

http://e-docs.bea.com/alsb/docs21/fbhelp/overview.html
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message and routes it to the business service of the B2B gateway. The gateway should be 
configured to route the message to the appropriate trading partner. 

Inbound Scenario
In the inbound scenario, Cyclone Interchange or any B2B gateway (configured to receive the 
message from the trading partner) sends a JMS message to the proxy service in AquaLogic 
Service Bus. The payload can be sent as is or as a file reference to the B2B gateway (file reference 
is not supported by Cyclone Interchange). AquaLogic Service Bus transforms the message and 
routes it to the business service defined for the backend system.

AquaLogic Service Bus and B2B Gateway Integration Via Web 
Service

Web services provide another integration option for AquaLogic Service Bus and Cyclone 
Interchange. Web services are the recommended transport mechanism for exchanging messages 
larger than 4MB. Although there are no file size limits with Web Services integration, consider 
the impact of document size at run time. If your organization plans to trade large files over Web 
services, see “Trading Large Files.”

There are two main scenarios to configure, which are based on the message direction. For more 
information, see Chapter 6, “AquaLogic Service Bus and B2B Gateway Integration Via Web 
Services.”

Outbound Scenario
In a typical outbound scenario, the backend system sends a SOAP message to the proxy service 
in AquaLogic Service Bus. This message must confirm to the WSDL file defined by the gateway. 
AquaLogic Service Bus then transforms the message and routes it to the business service of the 
B2B gateway. You must ensure that the B2B gateway is configured to route the message to the 
appropriate trading partner. 

Inbound Scenario
In a typical inbound scenario, Cyclone Interchange or any B2B gateway is configured to receive 
the message from the trading partner. It then sends a SOAP message to the proxy service in 
AquaLogic Service Bus. AquaLogic Service Bus transforms the message and routes it to the 
business service defined for the backend system.
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EDI Splitter 
From the trading partners, the received interchange files in Cyclone Interchange may contain 
more than one functional group which in turn may contain more than one transaction set. For 
efficient transformation, AquaLogic Service Bus expects one functional group, which has only 
one transaction set. 

To facilitate the splitting process, BEA provides an EDI Splitter component, which can be 
plugged to Cyclone Interchange. 

Note: At present, the EDI Splitter component is only available for Cyclone Interchange.

BEA EDI Splitter splits the incoming interchange into multiple interchanges so that each 
resultant interchange would contain only one functional group with one transaction set. BEA EDI 
Splitter provides splitting capabilities for both X12 and EDIFACT interchanges. 

In the inbound scenario where Cyclone Interchange sends the EDI messages to AquaLogic 
Service Bus, EDI Splitter should be enabled. For a given community, EDI Splitter can be enabled 
on the Pickup/Delivery exchange in Cyclone Interchange. 

Figure 3-3  Enable EDI Splitter 

EDI Splitter performs certain validations on the header/trailer segments for both X12 and 
EDIFACT. These validations could be presence of the header/trailer segments in the message, 
control number checking in header and trailer segments, checking number of 
segments/transaction sets/functional groups in header and trailer segments, and so on. If the 
validation fails only the corresponding transaction set/functional group/interchange is rejected 
and the rejection status is shown in the Message Tracker in Cyclone Interchange. 
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Figure 3-4  Message Tracker in Cyclone Exchange

Limitations of This EDI Solution
Some of the limitations of this EDI solution are:

This solution does not validate the EDI messages. You need to ensure that the incoming 
and outgoing messages are compliant with the EDI standards. 

Support for generating automatic functional acknowledgment is not available. 

For messages based on the EDIFACT standard, UNA segment is mandatory if the default 
delimiters not used. The default delimiters are: 

– ‘ (single quote) as segment terminator 

– + (plus) as element delimiter 

– : (colon) as sub-element delimiter 

– ? (question mark) as escape character 

– . (period) for decimal notation.
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C H A P T E R 4

Designing the EDI Solution

The following aspects need to be kept in mind when you design the EDI solution: 

The set of EDI protocols that will be used in the solution. This protocol could be AS1, 
AS2, AS3, FTP, or S-FTP. For more information about choosing the appropriate protocol, 
see “Protocol Matrix” on page 7-8.

The kind of transformation that is required by the solution. If you require EDI to XML 
transformation, you need to check if there is any existing transformation that can be 
leveraged or you may have to use MFL for EDI transformation.

To use MFL for EDI transformation, you can either manually write MFL maps to define 
the MFL or you can use SpecBuilder to generate gXML documents, which can then be 
used to generate the MFL document. The MFL documents must then be imported to 
AquaLogic Service Bus, using the AquaLogic Service Bus Console, to facilitate 
transformation. 

For more information about writing MFL documents, see 
http://e-docs.bea.com/alsb/docs21/fbhelp/overview.html.

To generate MFL document using gXML guideline document, you need to:

Identify the guidelines required by your organization.

Obtain the gXML guideline. 

You could use Edifecs SpecBuilder to export the EDI document to gXML format. 

Convert gXML to MFL format using BEA Batch Converter tool or EDI Importer plugin to 
Format Builder.

http://e-docs.bea.com/alsb/docs21/fbhelp/overview.html
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After transforming to MFL, import the MFL resource into AquaLogic Service Bus to 
facilitate transformation. 

You can use either JMS or web services to as transport mechanism when you integrate 
AquaLogic Service Bus and Cyclone Interchange. 

This section provides information about:

Generating gXML Documents Using Edifecs SpecBuilder

Transforming gXML Documents to MFL

Importing MFL Documents to AquaLogic Service Bus

Generating gXML Documents Using Edifecs SpecBuilder
This section explains the generation of gXML guidelines using the Edifecs SpecBuilder. This 
solution relies on the 0.71 version of the gXML. The steps for generating the gXML guidelines 
are as follows (The below steps provide generation of gXML guidelines for EDIFACT standard. 
The steps are similar for the generation of gXML guidelines for X12 standard).

Starting Edifecs SpecBuilder
To start Edifecs SpecBuilder

Select Start → Programs → Edifecs → Edifecs SpecBuilder. 

Creating an EDI Document
To Create an EDI Guideline Document

1. Select File → New. 

The New Document dialog appears. 

2. If required, select the EDI folder. 

3. Based on the EDI standard that you want to use, select + against the X12 or EDIFACT folder.
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Figure 4-1  Create X12-based EDI Document

4. Click + next to the required X12 or EDIFACT version and select the document type. 

5. Click Next.

The new guideline document is created.

6. Optionally, select the envelope segments for the document.

7. Click Finish. 

The EDI guideline document of the selected EDI standard and document type is created and 
opened in SpecBuilder Editor window. 
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Figure 4-2  SpecBuilder Editor Window

Exporting an EDI Document as gXML Document
After you create the EDI guideline document, it is automatically opened in SpecBuilder Editor 
window. You can now export it to gXML format. 

To Export an EDI Document as gXML Document

1. In the SpecBuilder Editor window, select File → Export. 

The Export Wizard appears. 

2. Select EDI gXML v0.8 and click Next. 

3. Specify the name and location of the exported file. 
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Figure 4-3  Export EDI Document to gXML Format

4. Click Next. 

5. Select version of gXML as gXML version 0.71 and click Next. 

6. Accept the default export options and click Next. 

7. Accept the default dictionary export options and click Next. 

The EDI guideline document is converted to EDI gXML format. 

8. Click Finish. 

The gXML document is generated with the file name specified in step 3. 

Transforming gXML Documents to MFL
You can transform gXML documents to MFL format using either the Batch Converter tool or the 
EDI Importer plugin to Format Builder. If required, you can use Format Builder to customize the 
EDI guideline.

Transforming to MFL Using Batch Converter Tool 
Batch Converter is a utility used for transforming a batch of gXML guidelines to MFL. 
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To transform gXML documents to MFL using Batch Converter 

1. From the command prompt, navigate to the BEA_HOME\weblogic91\integration\bin 
directory, where BEA_HOME is directory where AquaLogic Service Bus is installed. 

2. Run the batchconverter script as follows: 

batchconverter <source directory> <target directory> 

where,

source directory is the directory where the gXML documents are stored and target 
directory is the directory where the generated MFL documents will be stored. 

Note: On UNIX, use batchconverter.sh instead of batchconverter.bat.

The transformed MFL documents are stored in the specified target directory. 

Transforming to MFL Using the EDI Importer Plugin to Format 
Builder
EDI Importer plugin is integrated with Format Builder, a GUI tool for managing MFL 
documents. Using this plugin, you can import the gXML guideline as MFL document. If required, 
you can use Format Builder to customize the EDI guideline.

To Transform gXML Guideline Documents to MFL

1. To start Format Builder, select Start → Programs → BEA Products → Tools → Format 
Builder. 

2. Select Tools → Import → EDI Importer. 

EDI Importer dialog is displayed.

Figure 4-4  EDI Importer

3. Specify the name and location of the gXML guideline file. 
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Note: For transformation to occur, make sure that the gXML.dtd file is available in this 
location.

4. Click OK. 

The gXML guideline is transformed to MFL and is displayed in Format builder. 

Figure 4-5  Format Builder

Customizing the MFL Files
The messages that are sent and received should adhere to the EDI standards. For example, for a 
message based on the X12 standard, the ISA segment should be of length 106 characters 
(excluding the segment terminator).

Segment terminators that are supported by both EDIFACT and X12 standard are: \r\n\, \r, \n, 
‘, and ~. However, you can use Format Builder to support any other custom terminator. 

To Customize X12-based MFL File

1. Open the MFL file in Format Builder. 

2. Click + next to ISASegment and select ISA_Terminator.
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Figure 4-6  Customizing X12-based MFL File

3. Append the custom terminator to the existing list of literal values. 

Note: You can use comma (,) to separate multiple custom values. 

4. Click Apply. 

5. Select File → Save. 

To Customize EDIFACT-based MFL File

1. Open the MFL file in Format Builder. 

2. Click + next to UNASegment and select UNA_SegTerminator. 
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Figure 4-7  Customizing EDIFACT-based MFL File

3. Append the custom terminator to the existing list of literal values. 

Note: You can use comma (,) to separate multiple custom values. 

4. Click Apply. 

5. Select File → Save. 

Importing MFL Documents to AquaLogic Service Bus
MFL files can be manually defined as well as be generated using SpecBuilder and Batch 
Converter. The MFL documents must then be imported to AquaLogic Service Bus, using the 
AquaLogic Service Bus Console, to facilitate transformation. This section provides information 
about:

Getting Started with AquaLogic Service Bus
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Setting up a Project

Creating the MFL Resource File

Bulk Import

Getting Started with AquaLogic Service Bus
This section provides information about:

Creating a Domain

Extending the Domain

Starting AquaLogic Service Bus

Creating a Session

Creating a Domain
The Configuration Wizard guides you through the process of creating or extending a domain for 
your target environment using the configuration templates. 

For instructions on how to use the Configuration Wizard, see Creating WebLogic Domains Using 
the Configuration Wizard.

Extending the Domain
You can add product component functionality, or additional applications and services to an 
existing domain by extending it using the Configuration Wizard. To add the EDI solution 
functionality, you must extend your domain by adding the wlediutility.jar template to it.

To extend the domain, after creating the domain, you need to point to the location of the 
wlediutility.jar file. This file is located at 
BEA_HOME\weblogic91\common\templates\applications\

To Extend the Domain

1. Start →Programs→BEA Products →Tools→Configuration Wizard.

The Configuration Wizard is displayed. 

2. Select the Extend an existing WebLogic domain radio button and click Next. 

3. Specify the domain directory and click Next. 

http://edocs.bea.com/common/docs21/confgwiz/index.html
http://edocs.bea.com/common/docs21/confgwiz/index.html
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4. Select the Extend my domain using an existing extension template radio button. 

5. Specify the location of the extension template and click Next.

6. Specify the location of the wlediutility.jar file and click Next.

7. Accept the default values in the Customize JDBC and JMS Settings dialog and click Next.

8. The domain is now updated. Click Finish. 

Starting AquaLogic Service Bus
You can start AquaLogic Service BusBEA EDI Utilities using any one of the following methods:

From the Windows Start menu, select:

Programs→BEA Products →User Projects →domain_name →Start Server for BEA 
EDI Utilities Domain

Where domain_name represents the name you assigned your BEA EDI Utilities domain 
when you created it.

On Windows systems, invoke startWebLogic.cmd from the root of the BEA EDI 
Utilities domain.

On UNIX systems, invoke startWebLogic.sh from the root of the BEA EDI Utilities 
domain.

A server command console window, which shows status information about WebLogic 
Server is displayed.

Note: If you created a production mode domain, you are required to enter a valid user name and 
password to start the server. For more information about domains, see Creating 
WebLogic Domains Using the Configuration Wizard.

Creating a Session 
You must first start a session in the AquaLogic Service Bus Console. You can view resources and 
configurations in the AquaLogic Service Bus Console without being in a session, but to edit, 
change, or delete items or properties in a project, you must be in an active session. The Change 
Center manages sessions in the console as shown in the following figure. Sessions are saved as 
temporary files until the session is activated.

http://edocs.bea.com/common/docs21/confgwiz/index.html
http://edocs.bea.com/common/docs21/confgwiz/index.html
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Figure 4-8  Manage Sessions Using Change Center

The following table provides a summary of the Change Center functionality.

Table 4-1  Description of the Change Center

Note: It is good practice to save your configuration changes incrementally.

It is recommended that whenever you change a configuration in the console that you click 
Create before making any changes and that you click Activate when you have 
completed your changes to the configuration.

Setting up a Project
In the AquaLogic Service Bus Console, you can add new projects and navigate the project trees 
using the Project Explorer. Project folders can be collapsed and expanded as necessary. All 

Click… To…

Create Create a new session. You must create a session to make changes to the 
configuration. You can exit this session using the Exit function, then 
reenter it by clicking Edit. Once in the session you can continue to modify 
the resources. 

Edit Enter a session that you previously created and exited.

Exit Discontinue the session and save the session state. 

You can reenter the discontinued session by clicking Edit. 

Discard End the current session without saving the changes.

Activate Save the current session’s configuration to the run time. 

When you click Activate, the Activate Session page is displayed. In this 
page, the user and session name of the active session are displayed. If 
required, you can add a description. Click Submit to save the current 
session’s configuration to the run time. 
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project configurations are performed in the project page. Selecting a project or one of its 
sub-folders from the Project Explorer displays the information for that entity on the project page.

To uniquely identify the MFL document corresponding to the incoming message, the EDI 
solution relies on pre-defined folder structure for importing the MFL documents. Prior to 
importing the MFL resources, you need to create the following folder structure based on your 
requirements. 

Name of the standard. This could be either X12 or EDIFACT. 

Under the EDI standard folder, create a folder for each version of the EDI standard. For 
example, you could create a folder named 4020 for the X12 standard and a folder named 
D98B for the EDIFACT standard. 

For X12, the folder name should be the combination of version, release and sub-release. 
For EDIFACT, the version name should be the combination of version and release. 

Under the version folder, create a MFL resource with the name of the corresponding 
message. For example, the folder name could be ORDERS for EDIFACT or 850 for X12. 

For example, to import 850 (Purchase Order) document pertaining to 4020 version of X12, the 
folder structure should be as shown in the following figure:

Figure 4-9  Project Structure for EDI X12 Document

In this example, after creating the folder structure, specify 850 as the name of the MFL resource 
file. For more information, see Creating the MFL Resource File.

To Create a Project

Note: Make sure that you have started AquaLogic Service Bus. For more information, see 
Starting AquaLogic Service Bus.

1. To log on to AquaLogic Service Bus console, open a browser window and type 
http://localhost:7001/sbconsole.

2. Click Create in the Change Center to create a new session.

3. In the AquaLogic Service Bus Console navigation panel, select Project Explorer. 
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The Project Explorer pane is opened in the navigation panel and a project page is displayed 
in the console. 

4. Enter a name for the project in the Projects section. For example, type X12. 

5. Click Add Project.

The project is created and listed in Project Explorer under Projects.

To Create a Project Folder

1. In Project Explorer, click the project to open the associated project page.

2. On the Project Page, in Folders, enter the folder name in the field provided. For example, type 
4020. 

3. Click Add Folder. 

The folder is displayed in the list of project folders for the project.

4. After setting up the project, click Activate, then Submit to save the project directory 
structure.

Creating the MFL Resource File
After transforming the gXML guideline document to MFL, you need to import the MFL resource 
file to AquaLogic Service Bus. 

To Create the MFL Resource File

1. Click Create in the Change Center to create a new session.

2. In the AquaLogic Service Bus Console navigation panel, select Project Explorer. 

3. In Project Explorer, click the project name to expand the project, then click the folder to open 
it. 

4. In the Resources panel, from the Select Resource Type drop-down list, select MFL File.
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Figure 4-10  Select Resource Type

The Create a New MFL File Resource window is displayed. 

5. Enter the name of the MFL resource file. For example, type 850. 

Note: Make sure that the resource name is a valid X12 EDI message name. For more 
information, see Appendix B: Message Names for 4020 Version of X12 EDI 
Standard. For information about EDIFACT message names, see Appendix C: 
Message Names for D98B Version of EDIFACT EDI Standard.

6. Optionally, enter a description of the MFL resource file.

7. Click Browse to select the MFL file from the file system. 

You can also open the MFL file in a text browser, copy the MFL file content and paste in 
the Text area. 
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Figure 4-11  Create MFL Resource File

8. Click Save. 

The MFL resource is created and displayed in the Resources panel. 

9. Repeat the above steps to create all the required MFL files. 

10. Click Activate, then Submit to save the changes. 

Bulk Import
You can bulk import resources in to AquaLogic Service Bus using a ZIP or JAR file or from a 
URL. This allows registration of large numbers of resources at one time and provides the ability 
to get the WSDLs and included schemas, policies, and WSDLs of a proxy service in a JAR file. 
For more information, see “Importing Resources in Bulk” in Project Explorer in Using the 
AquaLogic Service Bus Console.

http://e-docs.bea.com/alsb/docs21/consolehelp/projectexplorer.html
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C H A P T E R 5

AquaLogic Service Bus and B2B 
Gateway Integration Via JMS

Java Message Service (JMS) offers a reliable integration mechanism between AquaLogic Service 
Bus and Cyclone Interchange. JMS is the recommended transport mechanism for exchanging 
messages up to 4MB in size. 

This section provides information about:

Outbound Scenario

Inbound Scenario

JMS Clustering

As shown in the following figure, the messaging service provides a layer of separation between 
the applications, which means that the underlying integration transport is reliable and 
independent of both AquaLogic Service Bus and Cyclone Interchange. 
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Figure 5-1  AquaLogic Service Bus and Cyclone Interchange Integration Via JMS 

JMS queues can be configured in WebLogic Server. Persistent queues are recommended to 
preserve messages in the event of a server outage. Persistent queues should be configured first in 
the WebLogic Server Console, AquaLogic Service Bus and then in Cyclone Interchange. 

In AquaLogic Service Bus, you need to configure the proxy services and business services for 
both inbound and outbound scenarios. AquaLogic Service Bus provides intelligent message 
brokering between business services (such as enterprise services and databases) and service 
clients (such as presentation applications or other business services) through proxy services that 
you configure using the AquaLogic Service Bus Console. Business services are AquaLogic 
Service Bus definitions of the enterprise services with which you want to exchange messages. 
Proxy services are AquaLogic Service Bus definitions of intermediary Web services that are 
hosted locally on AquaLogic Service Bus. Using the AquaLogic Service Bus Console, you 
configure a proxy service by defining its interface in terms of WSDLs and the type of transport 
it uses, the logic of message processing in message flow definitions, and by configuring policies. 

With AquaLogic Service Bus message brokering, service clients exchange messages with an 
intermediary proxy service instead of directly with a business service. A proxy service can have 
an interface that is identical (same WSDL and transport) to a business service with which the 
proxy service communicates, or the proxy service can have an interface that differs from that of 
the business service in terms of WSDL, transport type, or both. Since a proxy service can route 
messages to multiple business services, you can choose to configure a proxy service with an 
interface that is independent of the business services with which the proxy service communicates. 
In such cases, you would configure a message flow definition to route a message to the 
appropriate business service and map the message data into the format required by the business 
service's interface. 

In Cyclone Interchange, two JMS delivery exchanges are required: one for integration pickup and 
the other for integration delivery. While configuring the JMS delivery exchange, administrators 
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should select the correct JMS message type (BytesMessage or TextMessage). This decision 
should be based on what type the AquaLogic Service Bus is expecting. The JMS message type 
can be configured on the Advanced tab of the JMS delivery exchange's maintenance page in the 
Cyclone Interchange user interface, as shown in the following example. 

Figure 5-2  JMS Integration Delivery Exchange Settings 

When configuring Cyclone Interchange for JMS, the weblogic.jar file must be included in the 
classpath of the Cyclone Interchange server by placing a copy in the following location. 

[install directory]\[build number]\corelib 

For details about JMS configuration, refer to "JMS Transport" in "Delivery Exchanges" of 
Cyclone Interchange Installation and Configuration Guide. Make sure that the Cyclone 
Interchange engine is restarted after modifying the classpath. 

There are two main scenarios to configure, which are based on the message direction.

Outbound Scenario 
In an outbound scenario, the backend system sends a JMS message to the proxy service in 
AquaLogic Service Bus. The payload can be sent as is or as a file reference to the B2B gateway 
(file reference is not supported by Cyclone Interchange). AquaLogic Service Bus transforms the 
message and routes it to the business service of the B2B gateway. The gateway should be 
configured to route the message to the appropriate trading partner. 
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Figure 5-3  Outbound Scenario

Typical Tasks 
In AquaLogic Service Bus, you need to do the following tasks. For more information, see 
“Creating a Business Service”, “Creating a Proxy Service”, and “Configuring the Proxy Service”.

Configure the proxy service in AquaLogic Service Bus to listen to a JMS queue. This 
queue must be the same JMS queue to which the backend system sends the JMS message. 

Configure the business service in AquaLogic Service Bus to post messages to a JMS 
queue. This queue must be the same queue to which Cyclone Interchange's Integration 
Pickup Exchange (IPE) listens. So, after transformation AquaLogic Service Bus can post 
JMS messages to Cyclone Interchange via this queue. 

If you are using any other gateway, make sure that the business service post messages to 
the same queue to which the B2B gateways listens. 

Configure the proxy service to transform the XML message (incoming to AquaLogic 
Service Bus) to EDI message and route it to the business service of the gateway. 

To transform an incoming XML message to EDI message, you need to use the 
EDITransform action while configuring the message flow in AquaLogic Service Bus. You 
also need to configure an error pipeline so that if the transformation fails, the error pipeline 
can handle the failure scenario.

In Cyclone Interchange, you need to: 

Configure the community. This includes configuring, 

– Integration Pickup Exchange (configuration where Cyclone Interchange listens for 
messages from the backend system).

– Pickup/Delivery exchange (trading partner sends messages to this component).
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– Trading partner (the Delivery exchange of the trading partner should be configured 
based on the protocol agreed between the TP and community). 

If using EDIINT protocols (AS1, AS2, and AS3), configure the appropriate certificates. 

For more information, see Cyclone Interchange Administration Guide.

Configuring a JMS Queue
Make sure that you configure the required JMS queues before proceeding. For more information, 
see “Configure queues” in Administration Console Online Help, which is located at the following 
URL: 
http://e-docs.bea.com/wls/docs91/ConsoleHelp/taskhelp/jms_modules/queues/ConfigureQueue
s.html

Creating a Business Service
1. Start AquaLogic Service Bus. For more information, see “Starting AquaLogic Service Bus” 

on page 4-11.

2. To log on to AquaLogic Service Bus console, open a browser window and type 
http://localhost:7001/sbconsole.

3. Click Create in the Change Center to create a new session.

4. In the AquaLogic Service Bus Console navigation panel, select Project Explorer. 

The Project Explorer pane is opened in the navigation panel and a project page is displayed 
in the console. 

5. Click default. 

6. In the Resources panel, from the Select Resource Type drop-down list, select Business 
Service.

The Edit a Business Service - General Configuration page is displayed. 

http://e-docs.bea.com/wls/docs91/ConsoleHelp/taskhelp/jms_modules/queues/ConfigureQueues.html
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Figure 5-4  Create Business Service

7. Enter the name of the business service. 

8. Select Messaging Service as the Service Type and click Next. 

The Edit a Business Service - Message Type Configuration page is displayed. 
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Figure 5-5  Message Type Configuration of Business Service

9. Select Text as Request Message Type and click Next. 

The Edit a Business Service - Transport Configuration page is displayed. 

Figure 5-6  Transport Configuration of Business Service

10. Select JMS as the Protocol. 
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11. Type the endpoint URI and click Add. This URI must be the JMS Queue where Cyclone 
Interchange is listening for the incoming messages. 

This endpoint URI is displayed in the Existing URIs list. 

12. Click Next. 

The Edit a Business Service - JMS Transport Configuration page is displayed. 

Figure 5-7  JMS Transport Configuration of Business Service

13. Accept the default values and click Next. 

The Edit a Business Service - Summary page is displayed.
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Figure 5-8  Summary of Business Service Details

14. Click Save to accept the configuration settings and activate the session. 

The business service is created and displayed in the Resources panel.

Figure 5-9  Business Service Resource 

Creating a Proxy Service
Now, you need to create a proxy service for the business service. 
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To create a Proxy Service

1. Click Create in the Change Center to create a new session.

2. In the AquaLogic Service Bus Console navigation panel, select Project Explorer. 

The Project Explorer pane is opened in the navigation panel and a project page is displayed 
in the console. 

3. Click default. 

4. In the Resources panel, from the Select Resource Type drop-down list, select Proxy Service.

The Edit a Proxy Service - General Configuration page is displayed. 

Figure 5-10  General Configuration of the Proxy Service

5. Enter the name of the proxy service. 

6. Select Business Service as the Service Type and click Browse.

The Select Business Service page is displayed. 
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Figure 5-11  Select Business Service

7. Select the business service associated with this proxy service and click Submit. 

Note: Instead of selecting an existing business service, you can also select Message Service as 
Service Type. Later, when you configure this proxy service, you need to configure the 
route node based on your requirement. For more information, see “Adding a Route 
Node” in Proxy Services: Message Flow in Using the AquaLogic Service Bus Console. 

8. Click Next. 

The Edit a Proxy Service - Message Type Configuration page is displayed. 

Figure 5-12  Message Type Configuration of the Proxy Service

9. Accept the default values and click Next. 

http://e-docs.bea.com/alsb/docs21/consolehelp/proxymessageflow.html
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The Edit a Proxy Service - Transport Configuration page is displayed. 

Figure 5-13  Transport Configuration of the Proxy Service

10. Select JMS as the Protocol. 

11. Type the endpoint URI. Make sure that this URI is the JMS Queue to which the backend 
system sends the outgoing messages. 

12. Select Yes radio button to get all headers and click Next. 

The Edit a Proxy Service - JMS Transport Configuration page is displayed. 
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Figure 5-14  JMS Transport Configuration of the Proxy Service

13. Accept the default values and click Next. 

The Edit a Proxy Service - Summary page is displayed. 

14. Click Save to accept the configuration settings and activate the session. 

The proxy service is created and displayed in the Resources panel. 

Configuring the Proxy Service
Now, you need to configure the pipeline for this proxy service. 

To Configure the Proxy Service

1. Click Create in the Change Center to create a new session

2. In the Actions column associated with the proxy service, click the Edit Message Flow icon 
. 

The Edit Message Flow page for the proxy service is displayed. 
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Figure 5-15  Edit Message Flow of Proxy Service

3. Click the proxy node, then select Add Pipeline Pair. 

Figure 5-16  Configure Message Flow for the Proxy Service

4. Click the request pipeline , then select Add Stage.

5. Click the stage node, then select the Edit →Stage. 

The Edit Stage Configuration page is displayed. 

6. Click Add Action, then select EDITransform. 
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Figure 5-17  Add EDITransform Action

7. Click the <XPath> link. The XPath Expression Editor is displayed. 

8. In the XPath expression, specify the location of the XML message. 

For example, the XPath expression for accessing the message content would be 
./ns:message/ns:payload/ns:content, if the message structure in the $body variable 
is as follows:
<ns:Message xmlns:ns="http://openuri.org">

<ns:payload>

<ns:content> ....... </ns:content>

</ns:payload>

<ns:Message>

For Cyclone Interchange: 

a. In the XPath Expression text box, enter the following XPath expression:

.
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b. Click Save. You are returned to the Edit Stage Configuration page. 

9. In the variable text box, enter body.

10. Click the <XPath> link next to the “update” text. The XPath Expression Editor is displayed.

11. In the XPath expression, specify the location where the transformed message should be 
updated. For Cyclone Interchange:

a. In the XPath Expression text box, enter the following XPath expression:

.

b. Click Save. You are returned to the Edit Stage Configuration page. 

12. In the variable text box, enter body.

13. Specify the location of the temporary directory. 

For more information about this directory, see “Disk Volume Guidelines” on page 7-7

14. Select the Encoding (Base 64) check box if the content is Base 64 encoded. 

Figure 5-18  Configure EDI Transformation

15. Click Save. 
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Figure 5-19  Configuration of Proxy Service 

16. Optionally, you can configure an Error Handler for the request pipeline by adding Stage Error 
Handler. This provides a way to handle the transformation failures. 

17. Click Save to accept the configuration settings and activate the session. 

The proxy service has now been successfully configured. 

Inbound Scenario 
In the inbound scenario, Cyclone Interchange (configured to receive the message from the trading 
partner) sends a JMS message to the proxy service in AquaLogic Service Bus. The payload can 
be sent as is or as a file reference to the B2B gateway (file reference is not supported by Cyclone 
Interchange). AquaLogic Service Bus transforms the message and routes it to the business service 
defined for the backend system. 
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Figure 5-20  Inbound Scenario

Typical Tasks
In AquaLogic Service Bus, you need to do the following tasks. For more information, see 
“Creating a Business Service”, “Creating a Proxy Service”, and “Configuring the Proxy Service.”

Configure a proxy service in AquaLogic Service Bus to listen to a JMS queue. This queue 
must be the same queue to which Cyclone Interchange's Integration Delivery Exchange 
(IDE) posts JMS messages. 

Configure a business service to the JMS Queue where the backend system is listening for 
messages. 

Configure the proxy service to transform the incoming EDI message to XML message and 
route it to the business service of the backend system. 

To transform an incoming EDI message to XML message, you need to use the 
XMLTransform action while configuring the message flow in AquaLogic Service Bus. You 
also need to configure an error pipeline so that if the transformation fails, the error pipeline 
can handle the failure scenario.

In Cyclone Interchange, you need to:

Configure the community. This includes configuring,

– Integration Delivery Exchange (configuration where Cyclone Interchange posts 
messages to the backend system).

– Pickup/Delivery exchange (trading partner sends messages to this component).

– Trading partner (the Delivery exchange of the trading partner should be configured 
based on the protocol agreed between the TP and community). 

If using EDIINT protocols (AS1, AS2, and AS3), configure the appropriate certificates. 

For more information, see Cyclone Interchange Administration Guide. 
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Creating a Business Service
To create a business service, follow the steps described in “Creating a Business Service.”

Note: Make sure that the JMS Queue where the backend system is listening for the incoming 
messages is the endpoint URI when you specify the transport configuration of the 
business service in step 11. 

Creating a Proxy Service
To create a proxy service, follow the steps described in “Creating a Proxy Service.”

Note: Make sure that the JMS Queue where the Cyclone Interchange's Integration Delivery 
Exchange is configured is the endpoint URL when you specify the message type 
configuration of the proxy service in step 11.

Configuring the Proxy Service
To configure the proxy service, follow the steps described in “Configuring the Proxy Service.”

Note: While editing the stage configuration, in step 6 make sure that you select the 
XMLTransform action instead of the EDITransform action. In addition, in step 8, 
specify the location of the EDI message in the XPath expression. 

JMS Clustering 
If AquaLogic Service Bus and Cyclone Interchange are deployed in a clustered environment, then 
JMS queues must be clustered in WebLogic Server using distributed destinations. A distributed 
destination is a set of physical destinations (queues or topics) that are called under a single JNDI 
name so that they appear to be a single, logical destination to a client, even when the members of 
the set are actually distributed across multiple servers within a cluster, with each destination 
member belonging to a separate JMS server. Distributed destinations rely on physical JMS 
queues running on the servers in the cluster. For more information, see "Using Distributed 
Destinations" in Programming WebLogic JMS the WebLogic Server located at the following 
URL: 

http://e-docs.bea.com/wls/docs90/jms/dds.html 

The following figure shows AquaLogic Service Bus and Cyclone Interchange using distributed 
destinations, providing a clustered layer between both applications. 
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Figure 5-21  Distributed Destinations in a Clustered Environment 

Note: This figure shows Cyclone Interchange's staged HTTP servlet running in a high 
availability configuration on WebLogic Web servers in the DMZ to handle inbound 
messages. For more information, see “High Availability Staged HTTP” on page 7-3 

When configuring Cyclone Interchange, the only difference between using a physical JMS queue 
and a distributed destination is the JNDI URL. The JNDI URL should be a semicolon-separated 
list of the servers that are part of the distributed destination, as shown in the following example: 

t3://ls0005.cyclonesoftware.com:7001;t3://ls0006.cyclonesoftware.com:7001 

The following figure shows the Configure the JMS Settings page in Cyclone Interchange. In this 
page, you can set up a JMS integration pickup exchange. 
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Figure 5-22  JMS Transport Page in Cyclone Interchange 
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C H A P T E R 6

AquaLogic Service Bus and B2B 
Gateway Integration Via Web Services 

Web services provide another integration option for AquaLogic Service Bus and Cyclone 
Interchange. Web services are the recommended transport mechanism for exchanging messages 
larger than 4MB. Although there are no file size limits with Web Services integration, consider 
the impact of document size at run time. If your organization plans to trade large files over Web 
services, see “Trading Large Files.” 

This section provides information about:

Outbound Scenario

Inbound Scenario

Web Services Clustering

The following figure shows Web services integration for AquaLogic Service Bus and Cyclone 
Interchange.
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Figure 6-1  AquaLogic Service Bus and Cyclone Interchange Integration Via Web Service

Cyclone Interchange includes a built-in Web service that exposes a standard interface (API) in 
the form of a WSDL (MessageService.wsdl). This file resides in the following directory. 

[install directory]\[build number]\conf 

Outbound Scenario 
In a typical outbound scenario, the backend system sends a SOAP message to the proxy service 
in AquaLogic Service Bus. The payload can be sent as is or as a file reference to the B2B gateway. 
This message must confirm to the WSDL file defined by the gateway. AquaLogic Service Bus 
then transforms the message and routes it to the business service of the B2B gateway. You must 
ensure that the B2B gateway is configured to route the message to the appropriate trading partner. 

Figure 6-2  Outbound Scenario
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Typical Tasks
For the outbound scenario, the backend system must invoke operations on the 
MessageService.wsdl in order to send documents to the Cyclone Interchange's Web service. 
To send the ebXML/EDI documents, the backend system can use either of two methods 
(submitMessage or submitPayload) exposed by the Cyclone Interchange WSDL file. To 
enable the backend system to send SOAP messages to AquaLogic Service Bus, you need to: 

"Implement the submitMessage or submitPayload operation to allow the backend 
system to send a single outbound document to Cyclone Interchange. 

"Change the URL in the MessageService.wsdl to include the URL for the AquaLogic 
Service Bus proxy. 

<wsdlsoap:address 
location="http://localhost:5080/services/MessageService"/> 

In AquaLogic Service Bus, you need to do the following tasks. For more information, see 
“Creating a Business Service”, “Creating a Proxy Service”, and “Configuring the Proxy Service”.

"Configure the proxy service in AquaLogic Service Bus to listen to an endpoint URI to 
receive SOAP messages. This URI must be the same as the URI to which the backend 
system sends the SOAP message. 

"Configure the business service in AquaLogic Service Bus to send the SOAP messages to 
Cyclone Interchange web service. This web service must be the same service to which 
Cyclone Interchange's Integration Pickup Exchange (IPE) is configured. So, after 
transformation AquaLogic Service Bus can send SOAP messages to Cyclone Interchange 
via this service. 

If you are using any other B2B gateway, make sure that the business service is configured 
to the service to which that B2B gateway listens. 

"Configure the proxy service to transform the outbound XML message to EDI message 
and route it to the business service. 

To transform an outbound XML message to EDI message, you need to use the 
EDITransform action while configuring the message flow in AquaLogic Service Bus. You 
also need to configure an error pipeline so that if the transformation fails, the error pipeline 
can handle the failure scenario. 

In Cyclone Interchange, you need to do the following tasks:

"Configure the community. This includes configuring, 
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– Integration Pickup Exchange (configuration where Cyclone Interchange listens for 
messages from the backend system).

– Pickup/Delivery exchange (trading partner sends messages to this component).

– Trading partner (the Delivery Exchange of the trading partner should be configured 
based on the protocol agreed between the TP and community). 

If using EDIINT protocols (AS1, AS2, and AS3), configure the appropriate certificates. 

For more information, see Cyclone Interchange Administration Guide. 

Creating a Business Service 
1. Start AquaLogic Service Bus. For more information, see “Starting AquaLogic Service Bus” 

on page 4-11.

2. To log on to AquaLogic Service Bus console, open a browser window and type 
http://localhost:7001/sbconsole.

3. Click Create in the Change Center to create a new session.

4. In the AquaLogic Service Bus Console navigation panel, select Project Explorer. 

The Project Explorer pane is opened in the navigation panel and a project page is displayed 
in the console. 

5. Click default. 

6. In the Resources panel, from the Select Resource Type drop-down list, select Business 
Service.

The Edit a Business Service - General Configuration page is displayed. 
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Figure 6-3  Create Business Service

7. Enter a name for the business service.

8. Select Any SOAP Service as Service Type and click Next.

The Edit a Business Service - Transport Configuration page is displayed. 
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Figure 6-4  Transport Configuration of Business Service

9. Select http as the Protocol. 

10. Type http://localhost:5080/services/MessageService as Endpoint URI and click 
Add. 

The endpoint URI is displayed in the Existing URIs list. Cyclone Interchange web service 
provider runs in this default location. 

11. Specify the retry count and the retry interval to specify the number of times and frequency 
with which AquaLogic Service Bus will try to resend the SOAP message. 

12. Click Next. 

The Edit a Business Service - HTTP Transport Configuration page is displayed. 
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Figure 6-5  HTTP Transport Configuration of Business Service

13. Accept the default values and click Next. 

The Edit a Business Service - Summary page is displayed. 
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Figure 6-6  Summary of Client Business Service Details

14. Click Save to accept the configuration settings and activate the session.

The business service is created displayed in the Resources panel. 

Creating a Proxy Service 
Now, you need to create a proxy service for the client business service. 

To Create a Proxy Service

1. Click Create in the Change Center to create a new session.

2. In the AquaLogic Service Bus Console navigation panel, select Project Explorer. 

The Project Explorer pane is opened in the navigation panel and a project page is displayed 
in the console. 

3. Click default. 
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4. In the Resources panel, from the Select Resource Type drop-down list, select Proxy Service.

The Edit a Proxy Service - General Configuration page is displayed. 

5. Enter the name of the proxy service. 

6. Select Business Service as the Service Type and click Browse.

The Select Business Service page is displayed. 

Figure 6-7  General Configuration of the Proxy Service

7. Enter the name of the proxy service. 

8. Select Business Service as the Service Type and click Browse.

The Select Business Service page is displayed. 

9. Select the business service associated with this proxy service and click Submit. 

Note: Instead of selecting an existing business service, you can also select Message Service as 
Service Type. Later, when you configure this proxy service, you need to configure the 
route node based on your requirement. For more information, see “Adding a Route 
Node” in Proxy Services: Message Flow in Using the AquaLogic Service Bus Console. 

http://e-docs.bea.com/alsb/docs21/consolehelp/proxymessageflow.html
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10. Click Next. 

The Edit a Proxy Service - Transport Configuration page is displayed. 

Figure 6-8  Transport Configuration of the Proxy Service

11. Accept the default values and click Next. 

The Edit a Proxy Service - HTTP Transport Configuration page is displayed. 

Figure 6-9  HTTP Transport Configuration of the Proxy Service

12. Accept the default values and click Next.

The Edit a Proxy Service - Summary page is displayed. 

13. Click Save to accept the configuration settings and activate the session. 

The proxy service is created and displayed in the Resources panel. 

Configuring the Proxy Service
Now, you need to configure the pipeline for this proxy service. 
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To Configure the Proxy Service

1. Click Create in the Change Center to create a new session

2. In the Actions column associated with the proxy service, click the Edit Message Flow icon 
. 

The Edit Message Flow page for the proxy service is displayed. 

3. Click the proxy node, then select Add Pipeline Pair. 

4. Click the request pipeline , then select Add Stage.

5. Click the stage node, then select the Edit →Stage. 

The Edit Stage Configuration page is displayed. 

6. Click Add Action, then select EDITransform. 

7. Click the <XPath> link. The XPath Expression Editor is displayed.

8. In the XPath expression, specify the location of the XML message. For Cyclone Interchange:

a. Click Add Namespace and specify the prefix and URI.

Figure 6-10  Specify Namespace

b. In the XPath Expression text box, enter the following XPath expression:

./cins1:sendMessage/cins1:message/cins2:payload/cins2:content

c. Click Save. You are returned to the Edit Stage Configuration page. 
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Figure 6-11  Add XPath Expression

9. In the variable text box, enter body.

10. Click the <XPath> link next to the “update” text. The XPath Expression Editor is displayed.

11. In the XPath expression, specify the location where the transformed message should be 
updated. For Cyclone Interchange:

a. In the XPath Expression text box, enter the following XPath expression:

./cins1:sendMessage/cins1:message/cins2:payload/cins2:content

b. Click Save. You are returned to the Edit Stage Configuration page. 

12. In the variable text box, enter body.

13. Specify the location of the temporary directory. 

For more information about this directory, see “Disk Volume Guidelines” on page 7-7

14. Select the Encoding (Base 64) check box if the content is Base 64 encoded. 

15. Click Save. 
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16. Optionally, you can configure an Error Handler for the request pipeline by adding Stage Error 
Handler. This provides a way to handle the transformation failures. 

17. Click Save to accept the configuration settings and activate the session. 

The proxy service has now been successfully configured. 

Inbound Scenario 
In a typical inbound scenario, Cyclone Interchange is configured to receive the message from the 
trading partner. Cyclone Interchange then sends a SOAP message to the proxy service in 
AquaLogic Service Bus. AquaLogic Service Bus transforms the message and routes it to the 
business service defined for the backend system. The payload can be sent as is or as a file 
reference to the B2B gateway. 

Figure 6-12  Inbound Scenario

Typical Tasks
In this scenario, Cyclone Interchange sends a message to the AquaLogic Service Bus and the 
AquaLogic Service Bus transforms the message and sends the message to the backend system. In 
the inbound scenario, to receive documents from Cyclone Interchange, the backend system must: 

Expose a web service that implements MessageService.wsdl. This WSDL file is located 
in [install directory]\[build number]\conf). 

Provide an implementation (containing the business logic) for the sendMessage method. 

Cyclone Interchange always invokes the sendMessage method to send ebXML/EDI documents 
to the backend system. 

In AquaLogic Service Bus, you need to do the following tasks. For more information, see 
“Creating a Business Service”, “Creating a Proxy Service”, and “Configuring the Proxy Service”.
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Configure the proxy service in AquaLogic Service Bus to listen to an endpoint URI to 
receive SOAP messages. This URI must be the same as the URI to which Integration 
Delivery Exchange is configured to send the SOAP message. 

If you are using any other gateway, make sure that the proxy service URI is configured to 
the same URI to which that B2B gateway sends messages. 

Configure the business service in AquaLogic Service Bus to send the SOAP messages to 
the backend system web service. So, after transformation AquaLogic Service Bus can send 
SOAP messages to backend system via this service. 

For example, for a Web service implemented in WebLogic Server, the URI could be: 

http://server.host.com:7001/BackendService/MessageService/

The message service provides the implementation for the interface described in the 
MessageService.wsdl file. 

"Configure the proxy service to transform the incoming EDI message to XML message 
and route it to the business service. 

To transform an incoming EDI message to XML message, you need to use the 
XMLTransform action while configuring the message flow in AquaLogic Service Bus. You 
also need to configure an error pipeline so that if the transformation fails, the error pipeline 
can handle the failure scenario.

In Cyclone Interchange, you need to do the following tasks:

Configure the community. This includes configuring, 

– Integration Delivery Exchange (configuration where Cyclone Interchange posts 
messages to the backend system).

– Pickup/Delivery exchange (trading partner sends messages to this component).

– Trading partner (the Delivery exchange of the trading partner should be configured 
based on the protocol agreed between the TP and community). 

If using EDIINT protocols (AS1, AS2, and AS3), configure the appropriate certificates. 

For more information, see Cyclone Interchange Administration Guide. 

Creating a Business Service
To create a business service, follow the steps described in “Creating a Business Service.” 

Note: Make sure that the URI of the Web service implemented by the backend system is 
specified when you specify the transport configuration of the business service in step 10.
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Creating a Proxy Service
To create a proxy service, follow the steps described in“Creating a Proxy Service.”

Configuring the Proxy Service
To configure the proxy service, follow the steps described in “Configuring the Proxy Service.”

Note: While editing the stage configuration, in step 6, make sure that you select the 
XMLTransform action instead of the EDITransform action. In addition, in step 8, 
specify the location of the EDI message in the XPath expression.

Web Services Clustering 
HTTP load balancing is required in a clustered environment of AquaLogic Service Bus and 
Cyclone Interchange. The load balancer redirects message traffic when one service in the cluster 
becomes unavailable. The following figure illustrates Web services clustered integration for 
AquaLogic Service Bus and Cyclone Integration. 

Figure 6-13  Web Services Clustered Integration With Load Balancer 

For inbound traffic from Cyclone Interchange, AquaLogic Service Bus provides a software load 
balancer that can be configured when creating a clustered domain. For outbound traffic to 
Cyclone Interchange, either a software-based or hardware-based load balancer is required. For 
outbound traffic from AquaLogic Service Bus to Cyclone Interchange, load balancer hardware is 
required. The alternative is to use load balancer hardware for traffic in both directions. 

AquaLogic Service Bus and Cyclone Interchange must be configured to use the virtual IP address 
of the load balancer. 
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AquaLogic Service Bus – For outbound traffic to Cyclone Exchange, for the AquaLogic 
Service Bus Business Service, change the URL of the Cyclone Interchange's web service 
provider to the virtual IP address of the cluster as shown in the following example: 

http:// ls0005.cyclonesoftware.com:5080/services/MessageService 

In this example, the cluster virtual IP address is ls0005.cyclonesoftware.com. 

You can specify the endpoint URI when you specify the transport configuration of the 
business service. For more information, see “Creating a Business Service.”

Cyclone Interchange – For inbound traffic from Cyclone Exchange, change the Web 
Service's exchange URL to include the virtual IP, as shown in the following example. 

http://ls0005.cyclonesoftware.com:7021/CycloneB2BWebServicesOutbound/Me
ssageService/

In this example, the WebLogic load balancer application runs on port 7021 of the server 
named ls0005. 

The following figure shows the Configure the API client settings page in the Cyclone 
Interchange. You can configure the URL in this page. 

Figure 6-14  Web Services Clustering URL Example 
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C H A P T E R 7

Integration Guidelines for EDI Solution

This section provides information about the following topics:

Integration Guidelines for EDI and ebXML Documents

Monitoring Delivery of Outbound Payload

High Availability Staged HTTP

Trading Large Files

Protocol Matrix

Integration Guidelines for EDI and ebXML Documents 
Setting up a deployment that involves trading documents over EDI and ebXML requires prior 
knowledge of EDI standards and Collaboration Protocol Agreements (CPAs). The CPA 
document controls messaging characteristics (such as whether acknowledgements are used), 
signing and encryption, and duplicate elimination. 
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Monitoring Delivery of Outbound Payload
To keep track of the success or failure of the delivery of an outbound payload that it sends to 
Cyclone Interchange, the backend system can set the IntegrationId metadata for the outbound 
message. To do this, backend system must first register to receive event notifications from 
Cyclone Interchange. For more information about how to register to receive event notification, 
see "Events System" in Cyclone Interchange Installation and Configuration. 

After Cyclone Interchange is configured, it returns an event notification containing an 
IntegrationId attribute that corresponds to the outbound payload. For example, if the backend 
system sends two payloads to Cyclone Interchange, one bound for partner A 
(IntegrationId=1) and another bound for partner B (IntegrationId=2). If the first payload 
is successfully delivered, but the delivery of the second payload fails even after several retries 
because partner B is down, then Cyclone Interchange would fire two event notifications to the 
backend system similar to: 

"message delivered, IntegrationId=1" 

"message failed, IntegrationId=2" 

Note: The IntegrationId mechanisms works for both JMS and web services integration. 

Correlating Responses With Requests 
Backend system can use the RefToMessageId metadata element to correlate a business response 
with it’s business request. For an outgoing document, specify this metadata element in the 
message. To link an outbound document to an inbound document, this metadata element must 
contain the same value. For example, a 3A4 (Purchase Order) is a business request and a 3A7 
(Purchase Order Acknowledgement) is a business response. When Cyclone Interchange delivers 
the 3A4 document to the backend system, the MessageId field would be populated with a unique 
value (for example, 123). When the backend system responds by providing a 3A7 document to 
Cyclone Interchange, the backend system needs to populate the RefToMessageId metadata with 
the corresponding value (in our example, 123). This value is what Cyclone Interchange and the 
trading partner will use to link the specific request (3A4) with the specific response (3A7). 

For more information about implementing the backend system and about the Cyclone 
Interchange message metadata required for EDI and ebXML documents, see "Message metadata" 
and "ebXML support" in Cyclone Interchange Installation and Configuration. 
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High Availability Staged HTTP 
The following figure shows Cyclone Interchange deployed in a high availability configuration to 
handle inbound traffic. 

Figure 7-1  Staged HTTP High Availability Configuration 

In this scenario, multiple instances of the Cyclone Interchange staged HTTP servlet are 
configured in a cluster. This approach involves configuring staged HTTP servlets on multiple 
WebLogic web servers. A load balancer, either software-based or hardware-based, directs 
inbound traffic to each web server and automatically handles failover if an instance of the staged 
HTTP servlet fails. A trading partner sends messages using the virtual IP address of the load 
balancer. In this clustered configuration, each Cyclone Interchange instance requires a staged 
HTTP delivery exchange (the message protocol that a community or partner uses to send and 
receive messages) for receiving messages from trading partners. 

For information about setting up the staged HTTP servlet, see "Staged HTTP" in Cyclone 
Interchange Installation and Configuration. To configure Cyclone Interchange for high 
availability, follow the same procedures used for configuring multiple web servers. 
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Trading Large Files 
Various factors affect the manner in which an organization trades with partners. These factors 
could be 

Infrastructure, standards, and policies in the organization.

Hardware and software, preferred trading protocols, preferred message transports, and 
security policies in the organization.

Business practices followed by the trading partner.

Such factors might require specialized implementation to handle the exchange of large files 
among trading partners. 

Choosing AS1, AS2, or AS3 Protocols 
Other factors aside, AS3 FTP and AS2 HTTP are better suited for trading large documents 
between partners than AS1 SMTP or ebXML SMTP. The latter can be less desirable due to 
widespread corporate policies that impose limits on the size of e-mail messages. 

When choosing trading protocols, you and your partners should consider factors that may affect 
file size. For example: 

For AS1 SMTP, you need to know the message size limitations for mail servers in your 
organization and in your partner’s organizations. 

For AS2 HTTP and ebXML HTTP, set connection time-outs sufficiently high to allow 
documents to be successfully traded. In addition, for large documents, asynchronous 
receipts are preferred because synchronous responses can hold HTTP connections open for 
too long. 

File Sizes in Integration Via JMS 
JMS is the recommended transport mechanism for exchanging messages up to about 4MB in size. 

To trade large files using JMS, you need to install the WB1Y patch before using BEA EDI 
Utilities. For more information on how to download and apply this patch, see section Install Patch 
WB1Y in Chapter 1, “Installing EDI Utilities.” 
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File Sizes in Integration Via Web Services
Web services are the recommended transport mechanism for exchanging messages larger than 
4MB. For extremely large documents (larger than approximately 250 megabytes), use file system 
integration. 

File Size Matrix
The following table shows the matrix of certified file sizes for integration using JMS and web 
services. This matrix is based on testing done on a 3 GHz processor with 3 GB RAM and 
maximum heap size of 1280 MB.

Note: This EDI solution has no limitations related to the maximum size of inbound or outbound 
documents. File size limitation depends only on the hardware resources and software 
configuration for various transport mechanism used by you and your partner’s 
organization. You may have to conduct your own capacity tests to determine the optimal 
transport for your trading scenarios.

Delivering Documents 
The Cyclone Interchange Web Services API supports two ways of delivering documents between 
Cyclone Interchange and AquaLogic Service Bus. They are:

Passing entire documents over HTTP. For large documents, this approach is 
resource-intensive, and network time-outs may occur. 

Sending an URL that references the document rather than sending the document itself. 

The URL points to the document on a file system shared by the backend system, 
AquaLogic Service Bus and Cyclone Interchange. This approach reduces network traffic 
and works well for documents of file size up to approximately 250 MB. AquaLogic 

Table 7-1  File size Matrix

Client Protocol EDI Max Message Size XML Max Message Size

JMS payload as content 9 MB 72 MB 

JMS file reference 50 MB 500 MB

Web service payload as content 9 MB 72 MB 

Web service file reference 50 MB 500 MB
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Service Bus and Cyclone Interchange can run on the same server or reside on different 
servers. However, since the syntax of the URL path differs on UNIX and Windows, 
AquaLogic Service Bus and Cyclone Interchange must both run on the same operating 
system. 

To configure Cyclone Interchange to send an URL to AquaLogic Service Bus: 

1. Open the Integration Delivery Exchange for Web Services page in Cyclone Interchange. 

2. On the Advanced tab, select the Send the payload URL only radio button. 

Figure 7-2  Configure Integration Delivery Exchange in Cyclone Interchange

3. If you are using a web service to send outbound documents using the URL, set the URL in the 
URL field rather than in the Content field of the payload. This is because the payload can 
contain either content or an URL. 

For this approach, 250 MB file size limit is because of the manner by which Cyclone Interchange 
backs up documents. When a document is received from the Web Services API, it must be backed 
up before the message ID can be returned to AquaLogic Service Bus. For large documents, the 
Cyclone Interchange backup operation may take a long time. During backup, the HTTP 
connection between AquaLogic Service Bus and Cyclone Interchange remains open until 
Cyclone Interchange returns the message ID, so connection time-outs may occur for large 
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documents. The actual maximum file size would depend on the speed with which Cyclone 
Interchange can back up documents, as well as the time-out value set by the backend system. 

While configuring the proxy service in AquaLogic Service Bus, in the XPath expression, you can 
specify the location of the file reference that is directed either to the backend system or to Cyclone 
Interchange. For more information, see: Configuring the Proxy Service.

File System Integration 
For documents larger than approximately 250MB, use file system integration for AquaLogic 
Service Bus and Cyclone Interchange. For configuration instructions, refer to the "Delivery 
Exchanges" in Cyclone Interchange Installation and Configuration. 

Disk Volume Guidelines 
For deployments in which large files would be traded, capacity planning for storage space 
requirements is critical. Requirement analysis should include an estimate of the maximum 
volume of documents that might be traded at one time, and should consider growth in document 
volume over time. Cyclone Interchange and AquaLogic Service Bus uses a temporary directory 
to store documents in process. The space available for the temporary directory should be at least 
three times larger than the maximum aggregate size of the documents that are being processed.

The path of the Cyclone Interchange temporary directory is defined in the filereg.xml file, 
which resides in the following location: 

[install directory]\[build number]\conf 

The location of the temporary directory is specified while configuring the proxy service in 
AquaLogic Service Bus. For more information, see: Configuring the Proxy Service.

Tuning Guidelines for AquaLogic Service Bus 
Performance tuning becomes more critical for deployments in which large files are traded. For 
information about performance tuning in AquaLogic Service Bus, see: 

http://e-docs.bea.com/wls/docs90/perform/index.html 

For information about performance tuning in Cyclone Interchange, refer to Cyclone Interchange 
Installation and Configuration. 
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Protocol Matrix
The following table shows the protocols certified for message interchange between various 
clients and Cyclone Interchange. 

Table 7-2  Protocol Matrix

Client Protocol Cyclone Interchange & Client Integration 
Protocol

TP Protocol

Web service file reference Web service file reference AS1, AS2, AS3, FTP, SFTP

Web service payload as content Web service file reference AS1, AS2, AS3, FTP, SFTP

JMS payload as content JMS payload as content AS1, AS2, AS3, FTP, SFTP

JMS file reference Not supported by Cyclone Interchange. 
This has been tested independent of any 
B2B gateway. 
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Appendix A: Overburden Fault in 
Cyclone Interchange

When designing AquaLogic Service Bus business service to submit messages to the Cyclone 
Interchange Web service, make sure that you specify the Retry Count and Retry Interval while 
specifying the transport configuration of the business service. If AquaLogic Service Bus is unable 
to communicate with the Cyclone Interchange Web service, these values specify the number of 
times and frequency with which AquaLogic Service Bus will try to resend the SOAP message. 
For more information, see “Creating a Business Service” on page 6-4.

Cyclone Interchange may be unavailable because it is shut down (planned or unplanned), or 
because it is temporarily overloaded. Cyclone Interchange then throws a SOAP fault if it is too 
busy to handle the Web service request, as shown in the following example. 

Listing 7-1   Cyclone Interchange Overburden Fault in Cyclone Interchange

<?xml version="1.0" encoding="UTF-8"?> 

<xml-fragment xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 

xmlns:ns2="http://xml.apache.org/axis/" 

xmlns:xsd="http://www.w3.org/2001/XMLSchema" 

xmlns:ns1="http://cyclonecommerce.com/tradingengine/transport/api/webservi

ce" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<faultcode>soapenv:Server.userException</faultcode>

<faultstring>java.lang.Exception: Failed: System capacity has been 

exceeded</faultstring>
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<detail>

<ns1:fault 

xmlns:ns1="http://cyclonecommerce.com/tradingengine/transport/api/webservi

ce"/>

<ns2:hostname 

xmlns:ns2="http://xml.apache.org/axis/">ls0006</ns2:hostname>

</detail>

</xml-fragment> 
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Appendix B: Message Names for 4020 
Version of X12 EDI Standard

The message names for the 4020 version of X12 EDI standard are:

100 - Insurance Plan Description

101 - Name and Address Lists

102 - Associated Data

103 - Abandoned Property Filings

104 - Air Shipment Information

105 - Business Entity Filings

106 - Motor Carrier Rate Proposal

107 - Request for Motor Carrier Rate Proposal

108 - Response to a Motor Carrier Rate Proposal

109 - Vessel Content Details

110 - Air Freight Details and Invoice

111 - Individual Insurance Policy and Client Information

112 - Property Damage Report

120 - Vehicle Shipping Order

121 - Vehicle Service

124 - Vehicle Damage
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125 - Multilevel Railcar Load Details

126 - Vehicle Application Advice

127 - Vehicle Baying Order

128 - Dealer Information

129 - Vehicle Carrier Rate Update

130 - Student Educational Record (Transcript)

131 - Student Educational Record (Transcript) Acknowledgment

135 - Student Aid Origination Record

138 - Education Testing Results Request and Report

139 - Student Loan Guarantee Result

140 - Product Registration

141 - Product Service Claim Response

142 - Product Service Claim

143 - Product Service Notification

144 - Student Loan Transfer and Status Verification

146 - Request for Student Educational Record (Transcript)

147 - Response to Request for Student Educational Record (Transcript)

148 - Report of Injury, Illness or Incident

149 - Notice of Tax Adjustment or Assessment

150 - Tax Rate Notification

151 - Electronic Filing of Tax Return Data Acknowledgment

152 - Statistical Government Information

153 - Unemployment Insurance Tax Claim or Charge Information

154 - Secured Interest Filing

155 - Business Credit Report

157 - Notice of Power of Attorney

159 - Motion Picture Booking Confirmation
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160 - Transportation Automatic Equipment Identification

161 - Train Sheet

163 - Transportation Appointment Schedule Information

170 - Revenue Receipts Statement

175 - Court and Law Enforcement Notice

176 - Court Submission

180 - Return Merchandise Authorization and Notification

185 - Royalty Regulatory Report

186 - Insurance Underwriting Requirements Reporting

187 - Premium Audit Request and Return

188 - Educational Course Inventory

189 - Application for Admission to Educational Institutions

190 - Student Enrollment Verification

191 - Student Loan Pre-Claims and Claims

194 - Grant or Assistance Application

195 - Federal Communications Commission (FCC) License Application

196 - Contractor Cost Data Reporting

197 - Real Estate Title Evidence

198 - Loan Verification Information

199 - Real Estate Settlement Information

200 - Mortgage Credit Report

201 - Residential Loan Application

202 - Secondary Mortgage Market Loan Delivery

203 - Secondary Mortgage Market Investor Report

204 - Motor Carrier Load Tender

205 - Mortgage Note

206 - Real Estate Inspection



Append i x  B :  Message  Names  fo r  4020 Ve rs ion  o f  X12 ED I  S tandard

B-4 BEA EDI Utilities Solution Guide

210 - Motor Carrier Freight Details and Invoice

211 - Motor Carrier Bill of Lading

212 - Motor Carrier Delivery Trailer Manifest

213 - Motor Carrier Shipment Status Inquiry

214 - Transportation Carrier Shipment Status Message

215 - Motor Carrier Pick-up Manifest

216 - Motor Carrier Shipment Pick-up Notification

217 - Motor Carrier Loading and Route Guide

218 - Motor Carrier Tariff Information

219 - Logistics Service Request

220 - Logistics Service Response

222 - Cartage Work Assignment

223 - Consolidators Freight Bill and Invoice

224 - Motor Carrier Summary Freight Bill Manifest

225 - Response to a Cartage Work Assignment

240 - Motor Carrier Package Status

242 - Data Status Tracking

244 - Product Source Information

248 - Account Assignment/Inquiry and Service/Status

249 - Animal Toxicological Data

250 - Purchase Order Shipment Management Document

251 - Pricing Support

252 - Insurance Producer Administration

255 - Underwriting Information Services

256 - Periodic Compensation

260 - Application for Mortgage Insurance Benefits, A claim filed for mortgage insurance benefits

261 - Real Estate Information Request
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262 - Real Estate Information Report

263 - Residential Mortgage Insurance Application Response

264 - Mortgage Loan Default Status

265 - Real Estate Title Insurance Services Order

266 - Mortgage or Property Record Change Notification

267 - Individual Life, Annuity and Disability Application

268 - Annuity Activity

270 - Eligibility, Coverage or Benefit Inquiry

271 - Eligibility, Coverage or Benefit Information

272 - Property and Casualty Loss Notification

273 - Insurance/Annuity Application Status

274 - Healthcare Provider Information

275 - Patient Information

276 - Health Care Claim Status Request

277 - Health Care Claim Status Notification

278 - Health Care Services Review Information

280 - Voter Registration Information

283 - Tax or Fee Exemption Certification

284 - Commercial Vehicle Safety Reports

285 - Commercial Vehicle Safety and Credentials Information Exchange

286 - Commercial Vehicle Credentials

288 - Wage Determination

290 - Cooperative Advertising Agreements

300 - Reservation (Booking Request) (Ocean)

301 - Confirmation (Ocean)

303 - Booking Cancellation (Ocean)

304 - Shipping Instructions
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306 - Dock Receipt

309 - Customs Manifest

310 - Freight Receipt and Invoice (Ocean)

311 - Canadian Customs Information

312 - Arrival Notice (Ocean)

313 - Shipment Status Inquiry (Ocean)

315 - Status Details (Ocean)

317 - Delivery/Pickup Order

319 - Terminal Information

321 - Demurrage Guarantee (Ocean)

322 - Terminal Operations and Inter-modal Ramp Activity

323 - Vessel Schedule and Itinerary (Ocean)

324 - Vessel Stow Plan (Ocean)

325 - Consolidation of Goods In Container

326 - Consignment Summary List

350 - Customs Status Information

352 - U.S. Customs Carrier General Order Status

353 - Customs Events Advisory Details

354 - U.S. Customs Automated Manifest Archive Status

355 - U.S. Customs Acceptance/Rejection

356 - U.S. Customs Permit to Transfer Request

357 - U.S. Customs In-Bond Information

358 - Customs Consist Information

361 - Carrier Interchange Agreement (Ocean)

362 - Cargo Insurance Advice of Shipment

404 - Rail Carrier Shipment Information

410 - Rail Carrier Freight Details and Invoice
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411 - Freight Details and Invoice Summary (Rail)

414 - Rail Car-hire Settlements

417 - Rail Carrier Waybill Interchange

418 - Rail Advance Interchange Consist

419 - Advance Car Disposition

420 - Car Handling Information

421 - Estimated Time of Arrival and Car Scheduling

422 - Shipper's Car Order

423 - Rail Industrial Switch List

425 - Rail Waybill Request

426 - Rail Revenue Waybill

429 - Railroad Retirement Activity

431 - Railroad Station Master File

432 - Rail De-prescription

433 - Railroad Reciprocal Switch File

434 - Railroad Mark Register Update Activity

435 - Standard Transportation Commodity Code Master

436 - Locomotive Information

437 - Railroad Junctions and Interchanges Activity

440 - Shipment Weights

451 - Railroad Event Report

452 - Railroad Problem Log Inquiry or Advice

453 - Railroad Service Commitment Advice

455 - Railroad Parameter Trace Registration

456 - Railroad Equipment Inquiry or Advice

460 - Railroad Price Distribution Request or Response

463 - Rail Rate Reply
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466 - Rate Request

468 - Rate Docket Journal Log

470 - Railroad Clearance

475 - Rail Route File Maintenance

485 - Ratemaking Action

486 - Rate Docket Expiration

490 - Rate Group Definition

492 - Miscellaneous Rates

494 - Scale Rate Table

500 - Medical Event Reporting

501 - Vendor Performance Review

503 - Pricing History

504 - Clauses and Provisions

511 - Requisition

517 - Material Obligation

521 - Income or Asset Offset

527 - Material Due-In and

536 - Logistics Reassignment

540 - Notice of Employment Status

561 - Contract Abstract

567 - Contract Completion Status

568 - Contract Payment Management Report

601 - U.S. Customs Export Shipment Information

602 - Transportation Services Tender

620 - Excavation Communication

622 - Inter-modal Ramp Activity

625 - Well Information
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650 - Maintenance Service Order

715 - Inter-modal Group Loading Plan

805 - Contract Pricing Proposal

806 - Project Schedule Reporting

810 - Invoice

811 - Consolidated Service Invoice/Statement

812 - Credit/Debit Adjustment

813 - Electronic Filing of Tax Return Data

814 - General Request, Response or Confirmation

815 - Cryptographic Service Message

816 - Organizational Relationships

818 - Commission Sales Report

819 - Operating Expense Statement

820 - Payment Order/Remittance Advice

821 - Financial Information Reporting

822 - Account Analysis

823 - Lockbox

824 - Application Advice

826 - Tax Information Exchange

827 - Financial Return Notice

828 - Debit Authorization

829 - Payment Cancellation Request

830 - Planning Schedule with Release Capability

831 - Application Control Totals

832 - Price/Sales Catalog

833 - Mortgage Credit Report Order

834 - Benefit Enrollment and Maintenance
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835 - Health Care Claim Payment/Advice

836 - Procurement Notices

837 - Health Care Claim

838 - Trading Partner Profile

839 - Project Cost Reporting

840 - Request for Quotation

841 - Specifications/Technical Information

842 - Nonconformance Report

843 - Response to Request for Quotation

844 - Product Transfer Account Adjustment

845 - Price Authorization Acknowledgment/Status

846 - Inventory Inquiry/Advice

847 - Material Claim

848 - Material Safety Data Sheet

849 - Response to Product Transfer Account Adjustment

850 - Purchase Order

851 - Asset Schedule

852 - Product Activity Data

853 - Routing and Carrier Instruction

854 - Shipment Delivery Discrepancy Information

855 - Purchase Order Acknowledgment

856 - Ship Notice/Manifest

857 - Shipment and Billing Notice

858 - Shipment Information

859 - Freight Invoice

860 - Purchase Order Change Request - Buyer Initiated

861 - Receiving Advice/Acceptance Certificate
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862 - Shipping Schedule

863 - Report of Test Results

864 - Text Message

865 - Purchase Order Change Acknowledgment/Request - Seller Initiated

866 - Production Sequence

867 - Product Transfer and Resale Report

868 - Electronic Form Structure

869 - Order Status Inquiry

870 - Order Status Report

871 - Component Parts Content

872 - Residential Mortgage Insurance Application

875 - Grocery Products Purchase Order

876 - Grocery Products Purchase Order Change

877 - Manufacturer Coupon Family Code Structure

878 - Product Authorization/De-authorization

879 - Price Information

880 - Grocery Products Invoice

881 - Manufacturer Coupon Redemption Detail

882 - Direct Store Delivery Summary Information

883 - Market Development Fund Allocation

884 - Market Development Fund Settlement

885 - Retail Account Characteristics

886 - Customer Call Reporting

887 - Coupon Notification

888 - Item Maintenance

889 - Promotion Announcement

891 - Deduction Research Report
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893 - Item Information Request

894 - Delivery/Return Base Record

895 - Delivery/Return Acknowledgment or Adjustment

896 - Product Dimension Maintenance

920 - Loss or Damage Claim - General Commodities

924 - Loss or Damage Claim - Motor Vehicle

925 - Claim Tracer

926 - Claim Status Report and Tracer Reply

928 - Automotive Inspection Detail

940 - Warehouse Shipping Order

943 - Warehouse Stock Transfer Shipment Advice

944 - Warehouse Stock Transfer Receipt Advice

945 - Warehouse Shipping Advice

947 - Warehouse Inventory Adjustment Advice

980 - Functional Group Totals

990 - Response to a Load Tender

993 - Secured Receipt/Acknowledgment

994 - Administrative Message

996 - File Transfer

997 - Functional Acknowledgment

998 - Set Cancellation
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A P P E N D I X C

Appendix C: Message Names for D98B 
Version of EDIFACT EDI Standard

The message names for the version D98B of EDIFACT standard are as follows:

APERAK - Application error and acknowledgement message

AUTACK - Secure authentication and acknowledgement message

AUTHOR - Authorization message

AVLREQ - Availability request - interactive message

AVLRSP - Availability response - interactive message

BALANC - Balance message

BANSTA - Banking status message

BAPLIE - Bayplan/stowage plan occupied and empty locations message

BAPLTE - Bayplan/stowage plan total numbers message

BMISRM - Bulk marine inspection summary report message

BOPBNK - Bank transactions and portfolio transactions report message

BOPCUS - Balance of payment customer transaction report message

BOPDIR - Direct balance of payment declaration message

BOPINF - Balance of payment information from customer message

CALINF - Vessel call information message

CASINT - Request for legal administration action in civil proceedings message
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CASRES - Legal administration response in civil proceedings message

CHACCO - Chart of accounts message

COARRI - Container discharge/loading report message

CODECO - Container gate-in/gate-out report message

CODENO - Permit expiration/clearance ready notice message

COEDOR - Container stock report message

COHAOR - Container special handling order message

COLREQ - Request for a documentary collection message

COMDIS - Commercial dispute message

CONAPW - Advice on pending works message

CONDPV - Direct payment valuation message

CONDRA - Drawing administration message

CONDRO - Drawing organization message

CONEST - Establishment of contract message

CONITT - Invitation to tender message

CONPVA - Payment valuation message

CONQVA - Quantity valuation message

CONRPW - Response of pending works message

CONTEN - Tender message

CONTRL - Syntax and service report message

CONWQD - Work item quantity determination message

COPARN - Container announcement message

COPINO - Container pre-notification message

COPRAR - Container discharge/loading order message

COREOR - Container release order message

COSTCO - Container stuffing/stripping confirmation message

COSTOR - Container stuffing/stripping order message
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CREADV - Credit advice message

CREEXT - Extended credit advice message

CREMUL - Multiple credit advice message

CUSCAR - Customs cargo report message

CUSDEC - Customs declaration message

CUSEXP - Customs express consignment declaration message

CUSPED - Periodic customs declaration message

CUSREP - Customs conveyance report message

CUSRES - Customs response message

DEBADV - Debit advice message

DEBMUL - Multiple debit advice message

DELFOR - Delivery schedule message

DELJIT - Delivery just in time message

DESADV - Dispatch advice message

DESTIM - Equipment damage and repair estimate message

DGRECA - Dangerous goods recapitulation message

DIRDEB - Direct debit message

DIRDEF - Directory definition message

DMRDEF - Data maintenance request definition message

DMSTAT - Data maintenance status report/query message

DOCADV - Documentary credit advice message

DOCAMA - Advice of an amendment of a documentary credit message

DOCAMI - Documentary credit amendment information message

DOCAMR - Request for an amendment of a documentary credit message

DOCAPP - Documentary credit application message

DOCARE - Response to an amendment of a documentary credit message

DOCINF - Documentary credit issuance information message
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ENTREC - Accounting entries message

FINCAN - Financial cancellation message

FINPAY - Multiple inter-bank funds transfer message

FINSTA - Financial statement of an account message

GENRAL - General purpose message

GESMES - Generic statistical message

HANMOV - Cargo/goods handling and movement message

IFCSUM - Forwarding and consolidation summary message

IFTCCA - Forwarding and transport shipment charge calculation message

IFTDGN - Dangerous goods notification message

IFTFCC - International transport freight costs and other charges message

IFTIAG - Dangerous cargo list message

IFTMAN - Arrival notice message

IFTMBC - Booking confirmation message

IFTMBF - Firm booking message

IFTMBP - Provisional booking message

IFTMCS - Instruction contract status message

IFTMIN - Instruction message

IFTRIN - Forwarding and transport rate information message

IFTSAI - Forwarding and transport schedule and availability information message

IFTSTA - International multimodal status report message

IFTSTQ - International multimodal status request message

IMPDEF - EDI implementation guide definition message

INFENT - Enterprise accounting information message

INSDES - Instruction to dispatch message

INSPRE - Insurance premium message

INVOIC - Invoice message
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INVRPT - Inventory report message

IPPOMO - Motor insurance policy message

ITRRPT - In transit report detail message

JAPRES - Job application result message

JINFDE - Job information demand message

JOBAPP - Job application proposal message

JOBCON - Job order confirmation message

JOBMOD - Job order modification message

JOBOFF - Job order message

KEYMAN - Security key and certificate e management message

LREACT - Life reinsurance activity message

LRECLM - Life reinsurance claims message

MEDPID - Person identification message

MEDREQ - Medical service request message

MEDRPT - Medical service report message

MEDRUC - Medical resource usage and cost message

MEQPOS - Means of transport and equipment position message

MOVINS - Stowage instruction message

MSCONS - Metered services consumption report message

ORDCHG - Purchase order change request message

ORDERS - Purchase order message

ORDRSP - Purchase order response message

OSTENQ - Order status enquiry message

OSTRPT - Order status report message

PARTIN - Party information message

PAXLST - Passenger list message

PAYDUC - Payroll deductions advice message
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PAYEXT - Extended payment order message

PAYMUL - Multiple payment order message

PAYORD - Payment order message

PRICAT - Price/sales catalogue message

PRIHIS - Pricing history message

PRODAT - Product data message

PRODEX - Product exchange reconciliation message

PROINQ - Product inquiry message

PROTAP - Project tasks planning message

PRPAID - Insurance premium payment message

QALITY - Quality data message

QUOTES - Quote message

RDRMES - Raw data reporting message

REBORD - Reinsurance bordereau message

RECADV - Receiving advice message

RECALC - Reinsurance calculation message

RECECO - Credit risk cover message

RECLAM - Reinsurance claims message

REMADV - Remittance advice message

REPREM - Reinsurance premium message

REQDOC - Request for document message

REQOTE - Request for quote message

RESETT - Reinsurance settlement message

RESMSG - Reservation message

RESREQ - Reservation request - interactive message

RESRSP - Reservation response - interactive message

RETACC - Reinsurance technical account message
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RETANN - Announcement for returns message

RETINS - Instruction for returns message

SAFHAZ - Safety and hazard data message

SANCRT - International movement of goods governmental regulatory message

SLSFCT - Sales forecast message

SLSRPT - Sales data report message

SOCADE - Social administration message

SSIMOD - Modification of identity details message

SSRECH - Worker's insurance history message

SSREGW - Notification of registration of a worker message

STATAC - Statement of account message

STLRPT - Settlement transaction reporting message

SUPCOT - Superannuation contributions advice message

SUPMAN - Superannuation maintenance message

SUPRES - Supplier response message

TANSTA - Tank status report message

VATDEC - Value added tax message

VESDEP - Vessel departure message

WASDIS - Waste disposal information message

WKGRDC - Work grant decision message

WKGRRE - Work grant request message
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